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Important: 

These operating instructions cover both the Pro and Lite versions. If you have 
purchased the Lite version then please note that the following features are not 
available and are in italics throughout the instructions: Password protection, 

Automatic recording and altering the compression of recordings. Should you wish 
to upgrade to the Pro version then please call Sales on +44 (0)1932 779755. 
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Installation instructions 
System requirements 
 Pentium 500MHz or greater 
 At least 128MB of RAM 
 At least 1GB of free hard disc space (this may be more depending on how many calls you record) 
 Sound Blaster 16 compatible soundcard 
 Operating system: Windows 95, 98, NT, ME, 2000 or XP 
 Computer speakers – if you require these then please order Retell part number 218 from your supplier 

In your box 
 Software disc  
 Record and play telephone handset connector (part 157) or Ulytel telephone 
 This instruction book 
 

If you want to record from a cordless telephone or from the line side of the telephone (analogue telephone lines or 
analogue extensions only) you will need to purchase an additional connector (part 142). 

Installation of the hardware 
Record or play telephone handset connector  
This connector can either record telephone conversations or play them back down the telephone line.  
 
 
 
 
 
To record:  
 Switch the connector to ‘Record’ and unplug the telephone's handset (or headset) from the phone - 

you may need something sharp to press down the little lever that holds the plug in.  
 Plug the telephone handset connector in instead.  
 Plug the handset into the telephone handset connector (note that it is not designed to go between the 

phone and the wall socket- you will need to buy the optional part 142 to do this). 
 Plug the jack plug from the telephone handset connector into the mic socket on your computer 

(marked mic, or microphone or the socket with a symbol of a microphone.)  
 
To playback a call down the telephone line to someone at the other end:  
 This section only applies if you want to someone at the other end of the line to hear what you are 

playing back. If you just want to listen to a recording yourself , play back through your computer 
speakers or headset as you would any other sound on your PC. 

 Unplug the connector from the mic socket 
 Plug it into the speaker socket (if you have speakers attached to your PC you will have to unplug 

them).  
 Switch the connector to ‘Play’, select the recording you want to playback and click on play.  
 The person receiving the call will now hear the playback.  

 
If you experience recordings where only your voice is recorded then you handset is wired in reverse. To over come 
this problem you just switch the connector to ‘Play’ and it will reverse the wiring for you. 
If you have a Ulytel telephone 
This telephone has a built-in adaptor which allows you to record calls made and received from the 
telephone. It is supplied with a black lead with a 3.5mm jack plug on one end and a clear telephone plug 

It connects via the telephone handset, 
not the telephone line 
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the other. Plug the clear plug into to socket on the telephone marked with RECORD and the jack plug into 
the mic socket on your computer (marked mic, or microphone or the socket with a symbol of a 
microphone.) 
Optional connector (part 142) for recording from the telephone wall socket.  

 Unplug a telephone from the extension that you want to 
record from the wall socket.  

 Plug the 142 connector into the BT wall socket and the 
telephone line cord into the socket on the 142 connector.  

 Plug the clear plug from the 142 connector into the 
socket on the 157 connector and the jack plug from the 

157 connector into the mic socket on your computer.  
 The lead with a clear plug from the 157 lead is not used 
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Installation of the software 
THERE IS ONLY ONE DISC SUPPLIED WITH THE 957PRO. IT CONTAINS BOTH THE TRIAL VERSION AND THE FULLY 
LICENSED VERSION. IF YOU HAVE PREVIOUSLY INSTALLED THE 30 DAY DEMO VERSION YOU CAN ONLY INSTALL THE 
FULL VERSION AND YOU WILL HAVE TO SEND A REQUEST CODE TO RETELL TO HAVE YOUR PROGRAM UNLOCKED. 
ONCE YOU HAVE SENT A REQUEST CODE AND A RESPONSE CODE HAS BEEN SUPPLIED BY RETELL YOU ARE 
ACCEPTING THE LICENSING CONDITIONS OF THE SOFTWARE AND A REFUND FOR THE COST OF THE SOFTWARE IS 
NOT POSSIBLE. 

PLEASE FOLLOW THE INSTRUCTIONS BELOW TO INSTALL THE SOFTWARE ON YOUR COMPUTER. 

 Close all other applications that are currently running. If you are running your PC with Windows 2000 
or Windows XP then you must install the software under Administrator user. If you are running 
Windows NT then you cannot install version 1.63 and you must contact Retell for a copy of version 
1.61. 

 Create a folder to store your recordings in. If you are not sure where to create the folder, try creating 
it in C:\MyDocuments (where C is the letter of your hard disc). For example 
:\MyDocuments\Recordings. To do this, start Windows Explorer, select ‘My Documents’ directory in the 
C:\ tree, choose File=>New=>Folder in the Explorer menu, and rename the 'New Folder' to 
'Recordings'. 

 Insert the 957 installation floppy disk. 
 Press the Start button on the Windows task bar and choose 'Run'. Enter A:\Setup.exe . 
 The installation program will now ask you if you would like to install the 30-day demo version or the 

full working version. We suggest installing the 30-day demo version first as when the full version is 
installed and the license code is confirmed we cannot accept the software for refund. 

 Follow the on screen instructions to complete the installation process. 
 After the installation is complete you will be asked to 'launch the program file'. Check the box and 

press the 'Finish' button. 
 Now you have to select the directory where you want to store the recordings, this is the directory that 

you have created under step 2. All future recordings will be stored there. 
 If you chose the option to install the full version you will be asked to confirm the license code. The 

program will produce a request code that you can either use online at www.retellrecorders.co.uk to 
create your response code or you can call us (Monday – Friday between 9am – 5.30pm). When 
you receive the response code the program will be unlocked so you can use it.  

Configuring the software 
Before you use the software for the first time you must configure the software and soundcard by following 
these simple procedures.  
 Double-click on the handset icon on the status panel of the Windows taskbar (near to the system 

time). The software window will be opened.  
 Choose the 'Hardware' tab and check the following settings. Note: The software window floats on the 

top over all other applications; you may close it every time you want if it is not needed and open it 
again by double-clicking the icon. 

Sampling rate - This is the frequency (Hz) 
that the soundcard uses to digitise the signal 
that arrives at the line in or microphone 
socket. 44100Hz is CD quality. For telephone 
recordings, the default of 8000 Hz is perfectly 
adequate. Note: Increasing the sampling rate 
will increase the disk storage that is used for 
recordings and will affect the system 
performance when recording depending on the 
CODEC used (see later). 

http://www.retellrecorders.co.uk/
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Device - Make sure that the soundcard from which you want to record is selected. Even if your computer 
possesses only one soundcard, other devices like voice modems may appear here. Some soundcards (like 
the Creative SoundBlaster 128 PCI) appear twice in the list. In this case, consult the soundcards manual. 
Line – This selects what the volume control adjusts on the record tab. If blank it does not matter, it just 
means that you will have to go into the Windows volume control to adjust it.  
Start recording - Choose whether you want to have the hardware dedicated to listen to the input all the 
time and record when a signal comes (via line level) or if you want to start and stop the recording 
manually.  
Intelligent Recording Interface ® - Only select ‘active’ if you are using the Intelligent Recording Interface ® 
connector. If you are using the Retell 157 connector then select not ‘active’. 

Configuring your sound card  
The Retell 957 software will set up your soundcard automatically but should you experience recording 
problems then please check the following soundcard settings:  
 Click ‘Start’ => Programs => Accessories => Entertainment => Volume control.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 You will now see this screen. Click on ‘Options’ and ‘Properties’ and you will be taken to the screen 

below. 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 

 Make sure ‘Recording’ is selected 
and that ‘Microphone volume’ is 
selected. Click on OK. 

 If your soundcard has the 
advanced button under the 
Microphone settings then it is likely 
that you have a MIC boost 
facility. Click on the button and 
you will be taken to the screen 
on the left.  

 Make sure that there is not a tick 
in the Mic Boost box and click 
close. Sometimes Mic boost is 
labelled ‘+20Db’. 

  
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We recommend that you should make a few test recordings before you use the software. If you have any 
difficulties then test your system by using a computer microphone plugged into the mic socket as the software 
should be able to record from that for recording meetings in the same way that it can record from the 
telephone. If you have any difficulties then please contact Retell on 0871 42 42 444 and we can help you.  



 
 
 

- 9 - 

Recording 
Whenever the program is started automatically and the function 'Maximize on line signal' has been activated 
or it is started manually, the following will appear onscreen: 

 Reference and Note – You are now able to 
enter references (name of conversation 
partner) and make notes on the 
conversation. 

 Prev. Recording – this button has a special 
function allowing you to replay the last 
recorded conversation. eg. you have just 
hung up the telephone receiver and would 
like the conversation repeated. With a click 
of the button the software plays back the 
last entry. 

 Level control – allows the user to alter the 
level of recording. Attention should be paid 
to maintaining an even signal in the level 
display in the 'Recording level' meter. An 
average balance or 2/3 to 3/4 is a good 

setting. If the slider does not move then please refer to ‘Configuring your souncard’ section and adjust 
it manually. 

 Deactivate - allows the program to be shut down. To reactivate, the program must be started again. 
(Start => Programs => Retell Software Call Recorder). Note: The software is automatically started 
with each Windows session. Double-clicking the software icon in the system tray area of the task-bar 
can open the software window. 

 Stop Recording- this ends the recording of the current conversation and saves it to the default folder. 
If you don't want to save the conversation, click 'Cancel Recording'. Note: If the program is running in 
auto recording mode, pressing the 'Stop Auto Recording' button will suspend the auto mode. The 
program will no longer listen to the signals coming in until the 'Start auto recording' button is pressed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Manual Recording  - this will start and 
stop the manual recording.  
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Playback 
By clicking the 'Playback' tab, the contents of the 
selected recording folder are shown. All recordings are 
listed with date, time, length and further information 
(reference, notes and ID – the person who made 
the call). 
To play back a recording you can either double-click 
on it or highlight the recording and click the play 
button. If you double-click on a recording, the chosen 
conversation will be played back and any notes saved 
with the recording is displayed in the area beneath 
the list. 
During playback, you can navigate (fast forward, 
rewind, pause and stop) using the main button bar.  
The four buttons next to the main button bar are 
explained below. 

 
 
 

Adding a reference and note to a recording 
Highlight the recording that you want to add a reference and a note and click 
on the add note button (a hand holding a pencil). The add reference and 
note screen will open. 
Type in the reference for the call and the note you want to add in the Notes 
section and click OK. The reference and note will now appear next to the 
recording and if you double click on the recording the note will be displayed in the section below the 
recordings. 

Deleting Calls 
To delete a call you must always delete it through the software. Simply highlight the call you wish to delete 
and click on the green dustbin icon. 

Searching for a Recording 
You can search by five different methods: Identification, Reference, Note, 
and date of call and duration of call. Only click on ‘Close search window’ 
when you have finished listening to the recordings – this will bring back all 
of the stored recordings. 
 To search by the identification you type in the initials of the user whose 

calls you want to search for.  
 Type in the note or reference you wish to search for and the recordings 

will be brought up on the list.  
 If you know the date you had the call on and the time of day the call 

was made then type the date in the ‘date after’ field and the following 
day’s date in the ‘date before’ and the time to show the results for all the selected day. Eg: you want 
to see all the calls for 2002/05/02 you would type in 2002/05/02 in the Date after field and 
2002/07/02 in the date before field, at this point no calls will be shown as you have not specified the 
time of day. You must enter the earliest and latest possible times eg 09:00 is the earliest and 17:30 
the latest - this will now show the search result for 2002/05/02. If you want to search over a range 
of dates then just enter the earliest date in ‘Date after’ and the latest date in ‘Date before’.  

 Enter the minimum duration and the maximum duration for the call and all the possible results will be 
shown.  
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Saving a recording in WAV format 
 
This is useful for when you want to e-mail people recordings. To 
save a recording in WAV format you highlight the recording and 
click on the disc icon. It will bring up the ‘save’ screen: 
You can select where you wish to save the recording to and 
when you happy with where it will save it to just click save. It 
will automatically change it to WAV format. To test the recording 
you can just double click on the saved file and it will 
automatically play it back through Windows media player. 
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Advanced Settings 
Options screen 

Default folder for recordings – this is 
where you will find the directory you have 
previously selected during the installation. 
You can change the path to another 
directory anytime you want. 
Identification - is used in LANs. For 
example, by the initials of the user’s 
name. This can then be used as search 
criteria to find calls. Password - if you 
want to secure your recordings enter it in 
this space. If you give a password, all 
subsequent recordings are encrypted with 
it. Before you can playback those 
recordings, you have to enter the 
password that was used when the 
recording was done. Note that if you 
forget the password, the recording can 
never be played again. 

Autostart for all users- If you are using the software on a computer that is running Windows 2000 or XP 
you must put a tick in ‘Autostart for all users’ to ensure that the software automatically starts for each user. 
Encryption level – this sets the number of passes for the encryption algorithm to run over the recorded file. 
Due to the Waasenaer agreement, which restricts export of strong encryption algorythms, the encryption key is 
56 bits only. To improve encryption against code analysis and brute force attacks, raise the encryption level 
according to the performance of your computer system. 
Sensitivity - determines the signal strength (in percent of the maximal signal the hardware is able to 
process) that triggers recording (default setting is 5).If in auto mode and the software is recording all the 
time, you probably have too much line noise. In this case, raise the value to either 6 or 7. On the other 
hand, if the recording stops (for example because of quiet speech) lower the value to either 4 or 3 until 
the recording stops only after the conversation has ended. 
Signal duration to start  - determines the call length in seconds before the program will commence recording. 
This can be useful to prevent recordings due to clicks on the line rather than actual calls.  
Duration of signal absence to stop  - determines the length of time a signal must fail to sound before the 
program ends recording.  
Maximize on line signal  - determines whether the program will automatically pop-up on the desktop screen 
as soon as the conversation starts; when the box is ticked, the user may enter references and notes on the 
conversation immediately. 
 

CODECs 
 
These are available in the Pro version only. 
CODEC stands for Coder/Decoder. The program 
uses the CODECs that are in the Windows 
multimedia system to store audio data efficiently. 
Compared to uncompressed audio (.wav) files, 
using a CODEC reduces storage consumption 
radically. By default, the program uses the 
Microsoft CCITT G.711 provided that audio 



 
 
 

- 14 - 

compression Codecs are already available in the system. When modifying CODECs on the CODECs tab, it is 
important to note that the CODECs recording frequencies must correspond with the recording rate (sampling rate) 
of the sound card on the hardware tab. Note: To play with codecs may be rather tricky; if you are not 
technically skilled, you may decide to be happy with the G.711. 
 

 
 

CHOOSE A CODEC 

Check to ascertain which CODEC your system uses to function with the program and chose the appropriate 
CODEC most suited to your needs in recording quality and space effectiveness. The following table shows the 
characteristics of some common CODECs. Mass storage consumption has been measured in kilobytes per 
minute at a sampling rate of 8,000 Hz. 

 

WINDOWS CODEC PERFORMANCE CHART 
 

CODEC ~KB/min h/GB Speech 
quality 

Overall speech 
performance 

Music 
quality 

Overall music 
performance 

Creative ADPCM 235 74 high medium high medium 
Lernot&Hauspie 35 500 medium high medium high 
Lucent Technologies 
SX8300P 

63 277 high high medium medium 

MPEG layer3, 8000 bps 59 296 high high high BEST 
Microsoft CCITT G.711 468 37 high low high low 
Microsoft GSM 6.10 95 184 medium low medium low 
Microsoft IMA ADPCM 
4bit 

229 76 high medium high medium 

MS-ADPCM 4bit 240 72 high medium high medium 
MSN, 8200 bps 61 286 medium medium medium medium 
 
Conclusion: Depending on quality requirements, usually the MPEG layer3 CODEC is the best.  
 

 
 
How to install CODECs 
By default the following codecs are installed together with Windows:  
 DSP Group TrueSpeech Software Audio Codec  
 Microsoft Adaptive Delta Pulse Code Modulation (ADPCM)  
 Microsoft Interactive Multimedia Association (IMA) ADPCM  
 DSP Group Truespeech Software  
 Microsoft Groupe Special Mobile (GSM) 6.10  
 Microsoft CCITT (Consultative Committee for International Telephone and Telegraph) G.711 
 Microsoft PCM-converter  

 
You may gain access to more CODECs by clicking on the update button on your Windows Media Player. 
This will automatically connect to the internet and check to see if you already have the latest update. 
 
In case no CODECs are available for your system, they may be installed from the Windows CD-ROM 
following this procedure: 
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Use the Start menu => Settings => System Control. Double click the software symbol in the system control 
window.  
Next, click the 'Software Characteristics' in the 'Windows Set-up' tab.  
Choose 'Multimedia' and click the 'Details' button. 
Be sure to check off the 'Audio Compression' box. 
Click 'OK' and follow the instructions for installing the Windows features required. 
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File Management in the 957 Software 
We recommend that you have previous knowledge of file management in Windows before you attempt the functions 
below. 
The program has the ability to save calls to any folder you wish. This is useful for several reasons. You 
could keep a folder for each month of the year or a folder for each person in a call centre.  
It also has the facility to move calls between the folders and to also delete calls.  

Creating a new folder for recordings 
Firstly you must create the new folder through 
Windows Explorer. Make sure that you note down the 
exact path for the folder eg C:\recordings\January 
2001. Go into the software screen (usually by double 
clicking on the software icon on the taskbar) and 
click on the ‘Options’ tab.  
In the Default folder for recordings type in the path 
for the folder you created. 
This will now save calls to the path specified. 
 
 
 
 
 

 
 

Selecting the folder for playback 
You also have the ability to playback or move recordings in any folders. For the software to be able to do 
this you must first find the exact path of the folder if already created or create it through Windows Explorer. 
In the Playback screen click on the new folder icon.  
This will open the screen below to allow you to enter the name for the folder and the exact path of the 
folder. 

 
 
 
 
 
 

 
The folder name will appear and if you highlight that 
folder name then any recordings in the folder will 
show. Repeat the above for every folder that you want 
to view. 

Moving calls  
If you have created a folder to move recordings into 
then you must move the recordings through the 
software rather than Windows Explorer. If you try to 
move recordings through Windows Explorer the software will not be able to playback these calls. To move 
the call first highlight the folder that the recording is in that you want to move. Select the recording and 
drag and drop the recording into the folder you want to move it into. If you only want to copy the recording 
hold the CTRL button whilst dragging. 
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Deleting folders 
You can delete the folder from the folder list by highlighting it and clicking on the delete folder icon (the 
folder with a red cross through it). This does not delete all of the calls from this folder it only stops you 
from viewing them. You can always view the contents again by using the new folder icon and the method 
above. 

Auto delete function of the software 
The software has the ability to automatically delete the old recordings to save space on your hard disc. You 
have the option to select the time limit in the Options tab of the software under the ‘Automatically delete 
calls older than x days’ box. This function will only delete calls in the standard recording folder and it is 
limited to delete one call per minute. This function is disabled when the value is left at zero. 
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Networking the 957 Software 
The software has the ability to store calls in a central server for both archiving purposes and call monitoring 
by a supervisor. 

Setting-up the recordings folder 
Before you start to store your calls you must decide on how long a period of calls you wish to store in 
each folder such as a month, a week etc. On the server that you wish to store the calls on you must 
create a folder for the current period of recordings ie ‘Current Recordings’. This is the folder that will always 
have the latest calls stored in it. At the end of each archive period you re-name the folder eg January 
2001. You can then copy the calls to CDR for archiving or keep them on the hard disc. You then must 
create a new ‘Current Recordings ‘ folder for the next archive period.  

Setting-up the users 
If you are using the software on a computer that is running 
Windows 2000 or XP you must put a tick in ‘Autostart for 
all users’ to ensure that the software automatically starts for 
each user. 
 
You can either type the exact path of the folder or click the 
grey button and select the path manually. 
 
For the user to be able to view the current recordings the 
‘<default>’ folder must be highlighted under the Playback 
screen 
 
Each user must type their initials in the ‘Identification’ box. 

This will help when searching for an individual user’s calls. 
 
 
 
 
 
 

CODECS and Sampling Rates 
To enable the supervisor to playback any of the calls each user must be using the same CODEC and 
sampling rate. The most common CODECS are found in the table on page 4. 
It is important that the sampling rate that is chosen is also selected in ‘sampling rate’, which is in the 
Hardware screen. 
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Software Licence for the professional call recording software without 
permission for resale. 
Read the following licence conditions through carefully prior to installing the software on your computer. By 
installing and /or opening the software packaging, the user agrees to the following licence conditions. In case 
the user is not in agreement with the licence conditions, the software may not be used. In this case the 
user must return the programme package to the manufacturer immediately after the receipt or purchase in 
order to receive a full refund of the purchase price. The software is not sold to the user, but licensed to 
the user for the sole purpose of use. The user receives ownership of the diskette or CD and instructions as 
well as any other accompanying written documentation. 

Licensing Permission 
This licence will allow the user to use a copy of the software on a computer under the condition that the 
software is at all times exclusively used on one computer. The use of the software is defined as storing the 
software on a computer in temporary memory form (e.g. RAM) or in the permanent memory (e.g. hard 
drive, CD-ROM). If a multiple licence has been purchased, the use may only use as many copies of the 
software as has been agreed to. The user can also make a copy of the software as a back up. 

Copyright 
The software is copyright protected by the respective copyright holders. The software contains copyright 
protected material as well as confidential corporate information which must be protected by the user. It is 
forbidden to decompile, reassemble or alter the software or any parts thereof or related software products in 
any readable form, or furthermore to alter, modify, translate, rent, lease, lend, resell or produce the software 
or any of its parts. The copyright includes in particular the programme code, documentation, exterior 
appearance, structure, organisation or programme data, programme names, logos or any other forms of 
presentation with respect to the software. It is not permitted to reproduce, use, lend of alter the software 
contents unless explicit permission has been granted. 

Length of Licence  
Licensing permission is granted for an unlimited time, except in the case of demonstration versions, in which 
case the software will cease to function at some time. The licence automatically loses validity without explicit 
cancellation should any of the conditions contained within this agreement be infringed. In this case, the user 
is obliged to destroy all copies of the software in possession. The user may cancel the licence agreement at 
any time by destroying the software and all copies thereof. 

Limited Guarantee 
The supplier guarantees for a period of 12 months, beginning with the user's receipt of the software, that the 
software will function in a manner corresponding to the program description in the accompanying written 
material. 
The supplier gives no guarantee that the software will be suitable for the user's purposes or that the 
software is compatible with the user's existing software or hardware. The supplier cannot accept liability for 
any consequential loss or any loss of data. The supplier's maximum remedy for any and all issues is the 
refund of the cost of the software up to the normal retail price of the software. No liability can be accepted 
for any consequences of any unsatisfactory data backup or security. 

Response Codes 
There is only one disc supplied with the 957Pro. It contains both the trial version and the fully licensed 
version. If you have previously installed the 30 day demo version you can only install the full version and 
you will have to send a request code to Retell to have your program unlocked. Once you have sent a 
request code and a response code has been supplied by Retell you are accepting the licensing conditions of 
the software and any request for a refund for the cost of the software will not be accepted. 
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Self Help Guide for the 957 Program  
Please consult the following self help guide below before contacting Retell. If you still have difficulties then 
please contact our technical team on 0871 42 42 444 (UK only) or +44(0) 1932 779755 
 

Problem Possible Cause Solution 
There is a window on my screen 
asking for a response code 

You have reached the end of your 
30-days trial or you have chosen 
to license the software as you 
installed it 

Either e-mail Retell the request 
code or call us on 01932 779755 
and select option 1 between 9am-
5.30pm Monday –Friday. We will 
give you a response code that will 
allow you carry on using the 
software 

Near party recordings are quiet 
whilst using a headset with a 
voice tube 

The voice tube is blocked  If the voice tube on your headset 
is blocked then try 
cleaning/replacing it. 

I cannot get the software to record 
or there is no record level. 

Soundcard has not been set-up 
correctly 

Please refer to the ‘Configuring 
your soundcard’ section – if this 
does not help then please refer to 
the advanced FAQ section. 

I cannot get the software to auto 
record. 

The auto record has not been 
enabled.  

Under the Hardware tab the 
section marked ‚Start recording‛ 
make sure the ‚Via line level‛ 
has been selected, then click on 
the Record tab and make sure the 
right hand button (along the 
bottom) says Stop Auto 
Recording. 

The error message ‘Couldn’t open 
an ACM stream for pcm-to-driver 
conversion’ 

The Sampling Rate is not set 
correctly 

Make sure the sampling rate under 
the hardware tab matches the 
available format under the 
CODECS tab. Also make sure you 
have not selected a stereo 
CODEC as these are not available 
for the software. 

Every time I pick-up the telephone 
the software screen pops-up in 
front of my other programs 

‘Maximise on Line signal’ under 
the Options tab has been ticked 

Select the options tab and remove 
the tick from ‘Maximise on Line 
Signal’ 

I want to link my database with 
the Software (eg to insert a 
contact number with the relevant 
telephone call) 

 If you are using the Pro or Adv 
version of the software you can 
buy Retell part number 957LINC. 
This has the possibility to insert 
various items from your database 
into the notes and reference field 
of the 957 Software. 

When using the 157 connector 
only my voice is recorded – the 
far party is quiet 

Your handset may have reverse 
wiring 

Try the 157 in the play position or 
call Retell to ask about the 
Intelligent Recording Interface 
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Advanced Frequently Asked Questions (FAQs) on the 957 Program. 
 

Q. I get a buzzing/humming sound on my recordings. What is it? 
A. How old is your computer monitor? If your monitor is very old and does not comply with MPR2 
emissions standards it may be sending hum into the telephone connector. Move the phone and telephone 
connector further away from the monitor. 

Q. I have it on auto recording but it never switches off. 

A. Check the question about getting buzzing/humming on the recording. Also turn up your speakers while on 
hook, and tap your handset or headset. If you can hear the tapping through the speakers, then the 
microphone in your handset or headset is live all the time even when the phone is on hook. Ask you phone 
maintainer to turn off the microphones when on hook through the software if this is possible, or reduce the 
record level through Windows volume control slightly.  
Q. My recordings are quiet with a lot of hiss. On another computer I can hardly get a recording at all. 
A. With your soundcard there may be a setting to amplify or increase the level of the MIC in source. If so, 
try clicking this option.  

Q. I cannot get the product to record.  What shall I do? 
A. There could be a connection problem with or a sound problem or a CODEC problem. Try using the 
Sound Recorder that comes with Windows to record from the Telephone handset connector (deactivate the 
957 first in case they conflict with each other). If that works, then there cannot be any fault with the 
Telephone handset connector, connection and input etc.  

Most reasons why the 957 do not record are to do with the soundcard settings. Go carefully through the 
‘Configuring your soundcard’ section.  

Try experimenting with different CODECS and different sampling rates. There is a big difference in sound 
quality between different CODECS, and some will not work at all. Make sure that the sampling rate on the 
CODEC tab is the same as the sampling rate on the hardware tab. 

Go to the Options tab. Try changing the Sensitivity (in % of max. line level) value and decrease it to say 
around 3 or 4.  

Pay attention as some sound cards have different settings for recording and for playback. The 957 records 
from the output of the soundcard, so it is important for the soundcard to be set correctly, although it is 
difficult for us to advise on any particular soundcard as there are so many variations and it is not supplied 
by us. 

Some soundcards have a ‚microphone boost‛ or similar that can be selected. Try selecting this. If the 
recording level bar moves that is a good sign. 

Sometimes there are two volume controls, one in Windows and one for the soundcard. You would need to 
make sure that both of them are up. 

Q. On play back I just get a second or two of recording and then it stops. 
A. It sounds like a CODEC issue. Experiment with different CODECS and different sampling rates and try 
again. 

Q. I have got ISDN. Can I still use it? 
A. Yes. The Telephone handset connector (model 157) is designed to fit between the handset and the base 
of the telephone so it will not be affected by ISDN.  

Q. It won’t play back any calls I have made. 
A. There are two possible causes. Either the program is still recording  - in this case on the record screen 
click the bottom right key ‘STOP AUTO RECORDING’ (Pro version only) to enable you to play back your 
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recordings. Remember to click on START AUTO RECORD (Pro version Only) after you have finished 
playing your calls. Or you do not have a Duplex soundcard – please refer to the System Requirements for a 
suitable soundcard. 

Q. The recordings seem to be very quiet. Is it the fault of the 957? 
A. The software only affects the recording quality to the extent that different sampling rates and CODECs are 
selected. There are many different soundcards all with different characteristics of level and sockets. Start by 
checking that the levels are up on the controls in your soundcard. If there is a MIC boost option in the 
Windows volume control (you will find it under the advanced section) then please select it.  

Q. Does the size of the file go up as the encryption level goes down? 
A. No. The encryption level is just the number of times the algorithm passes over the file. This will increase 
the protection against brute-force/code analysis attacks against encrypted files. 

Q. How can you reduce the Encryption Time?   
A. There are three strategies to get it faster: 

- The encryption of the audio data is done in the main memory. Generally, the more main memory the 
system has, the better performance it shows when preparing the data. If there is not enough free main 
memory, the system begins swapping it on hard disk. 32-64 MB should be suitable for the most needs - 
depending on the operating system.  

- Reduction of the time needed to encrypt the data is possible if you decrease the encryption level settings 
in the 'general preferences' tab. The relation is a linear one. 

- Using compression codecs with higher ratio will decrease the amount of data to be encrypted, thus the 
encryption time. Reducing the sampling rate will have the same effect. A rate of 8,000 samples per second 
(Hz) will match the bandwidth of the telephone quite good. 

Q. A customer phoned us to say that they uninstalled the 957 using the control panel, but now, every time they boot 
up their computer they receive a message saying something about ‚Cannot find the file C\progam\retell957 
archiver\telar.exe or some of its components.  
A. You have to manually remove the program through the regedit screen: 

From the start menu choose RUN. Type regedit. Choose key HKEY_CURRENT_USER\ Software\ Microsoft\ 
Windows\ CurrentVersion\Run 

Delete the TELAR value of this key. 

Q. My computer also runs DOS windows. Will this upset the working of the program? 
A. No, it should not. 

Q. The program cannot record and playback at the same time, can it? 
A. No. This is necessary because running a soundcard in duplex mode can interfere with the CODEC 
architecture. In fact, the soundcard runs in duplex mode if you play back while the application is in auto 
recording mode and listens to the line signal.  

Q. If the hard disk becomes full I presume that the software would just stop. It would not overwrite the oldest file 
like a loop would it? 
A. No. It will simply give an error message. You can set the software to overwrite old recordings if you 
select it through the Options tab. 

Q. One customer has the following error message: ‚MMSYSTEM004 The specified device is already in use. Wait 
until it is free, and then try again. Is this issue to do with CODECs? 
A. No. It has to do with the soundcard device driver. Some other program seems to access the driver 
before the software can. It could also be that you have started two copies of the software by mistake.  
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Q. What sort of recording time can I expect per Gb 
A. An example of one of my calls was as follows - MS-ADPCM Codec, 8000 Hz, 4 bit, mono, Encryption 
level 1, 26 min 11 sec call, 6.276 Mb file size.  I believe this works out at roughly 13 Mb per hour with 
that codec, etc., which gives around 1.3 Gb per 100 hours, which is 12.5 days for one line constantly in 
use for 8 hours per day. Depending upon the codec and sampling rate you can get any ratio of recording 
quality to disk spaced used that you want. For example up to around 873 hours per Gb! We have a 
separate table available of some of these values. 

Q: What is Sampling rate? 
A: Sampling rate under the hardware tab is used to set the frequency in which the sound card hardware 
grabs the line signal. 44100 is CD quality. 8000 is a good choice for phone calls. Make sure that the 
CODEC is set to the same sampling rate or you will not be able to record. 

Q: What is the purpose of the 'password' option that is available - does it protect individual recordings?  
A: It will protect all subsequent recordings but it is available on the Pro version only.  

Q. I can create a folder in the software then copy files into it within the software but it does not seem to be there at 
all in Windows Explorer. I have reinstalled the demo but it does not make any difference. 
A. Please refer to the section ‘File Management in the 957 Program ’ where creating new folders is 
explained in full. 

Q. The option to 'lock users out of the program' is important as once the program is loaded as we do not want the 
users to gain access to the program. Only the supervisors should have access. 
A. This would require a short individual adaptation. Remember though that the user could disconnect the 
telephone handset connector the phone line or from the socket on the sound card if they did not want to 
record a call. 

Q. What installation would a supervisor need on their PC to playback the various recordings? 
A. An installation of the program will allow the supervisor to playback the files or the TelAr_Index.DAT file 
but it needs to be installed on every remote PC. We have an emergency tool to recreate the index file in 
case it is lost but some information cannot be recovered. 

Q. We're copying the recordings from the agent PC to a supervisor PC for playback. These are stored in different 
sub-directories and the supervisor cannot navigate in or out of these sub-directories when in the 'Playback' tab. 
A. You should be able to access these sub directories by pressing the new folder button on the playback 
screen and entering the path. Then you can switch between the folders simply by clicking the folders list 
box. 

Q. What is the admissibility of a software recording into a court of law?  In the past I have looked at some 
recorders that used wav files, but obviously they can be tampered with easily using widely available software. With 
this in mind, how bullet proof would a 957 recording be once it has been made and encoded?  i.e. could the 
encoded file be tampered with, or could the date and time stamp be tampered with?  We want to guarantee the 
security of the file once it has been encoded. 
A. First, nobody can give a guarantee. It is easy to just set the system clock to another date, if someone 
wants to deceive. Another thing is that if an employee has to make a statement as a witness or for 
circumstantial evidence or to prove a statement, such a file could be useful. As I stated, on default, the 
*.957 files are encrypted using the filename and will not be played without the correct name, which has the 
start time in it. A code analysis attack would take some effort even for a sophisticated hacker. To simply try 
out some common encrypting algorithms will not work, since the algorithm is not a standard one. 

 

If you are still experiencing problems with the software then please call Retell’s technical department on 0871 
42 42 444 or e-mail technical.helpdesk@retell.co.uk .

mailto:technical.helpdesk@retell.co.uk
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Optional Extras 
Connector to Record from Cordless Telephones and Analogue Telephone Wall Sockets (BT 
Style) – Retell part number 142 
If you want to record from a cordless telephone or from the BT telephone wall socket then you will need to 
purchase this additional connector. It is only suitable for recording from UK 
BT style analogue telephone sockets. 
 
 
 
 
 
 
 
 

Computer Loudspeakers – Retell part number 218 
These are essential for the playback of recorded telephone conversations. 
Specification: 
 Mains Powered 
 Magnetically shielded for safe use near computer monitors 
 P.M.P.O: 120W 
 Power Lamp 
 Volume Control 
 Ear Jack Socket – for private listening 
 Dimensions: 75(W)x185(H)x120(D) mm 

 
 
 

 
Stereo Headphones – Retell part 216 
Ideal for private listening of recorded calls and comfortable for long term 
use. 
Can be plugged direct into the ‘speaker-out’ socket on your soundcard 
or into the headphone jack of computer loudspeakers. 
Specification: 
 Impedance: 22-32 Ohm 
 Sensitivity: 101dB S.P.L. at 1KHz +/- 2% 
 Length of cord: 1.2m +/- 3% 

 

Recommended Soundcard  - Retell part 959 
If your computer does not have a duplex soundcard then Retell recommend this product. 
Specification: 
 Full Duplex play and recording 
 Mic in, Line in and Line out  
 Compatible with Windows 95, 98, 2000, ME and NT 4 
 Minimum System requirements: 233MHz CPU, 16MB RAM, CR–ROM drive, spare PCI slot 
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Data Integration Linc Software (Retell part 957LINC) 
Allows the Pro an Adv Recording software to be integrated with the users’ database. It inserts the selected 
data to either the reference or notes field of the Pro Software. Examples of applications are: 
 Inserting Customer contract number to the relevant telephone conversation 
 Inserting the telephone number and name of the person spoken to 

The software is supplied with installation guide and example applications and requires installation by your IT 
manager. 
  



 
 
 

- 26 - 

Legality of Recording 
Legality of Call Recording 
Ofcom says that you should make every reasonable effort to inform all parties to a call that it may or will 
be recorded, silently monitored or intruded into. They say that it is up to you how you do this and that 
acceptable options, depending on circumstances, might include warning tones, pre-recorded messages, spoken 
warnings by the operator or written warnings included in publicity material, telephone directories, contracts, 
terms of business, staff notices etc. Ofcom says that it may not always be possible to warn first time callers 
with whom you have had no previous contact but what is important is that you have a systematic procedure 
in place, which provides the necessary information where this is a realistic possibility. Ofcom also suggest 
following on a ruling from the European Court of Human Rights that staff are told of a phone that they can 
call from which will not be recorded.  
If you require further information or for the latest updates since this leaflet was printed contact 
www.ofcom.org.uk or contact them direct at: Phone: 0845 456 3000 or 020 7981 3040. 
Email:contact@ofcom.org.uk, Fax: 0845 456 3333  
Post: Ofcom Contact Centre 
Riverside House 
2a Southwark Bridge Road 
London 
SE1 9HA 
(Note that Ofcom has taken over Ofcom's responsibilities)Check www.retellrecorders .co.uk for information on 
recording staff or individuals. 

Legality of Connection to the Line 
Retell products carry a CE mark and are subject to an EMC Declaration of Conformity and EC safety 
regulations. A copy is available on request. Old BABT green circle logos are now superseded by these new 
regulations. Retell products in most cases do not require connection into the Public Switched Telephone 
Network. 

Guarantee 
Retell undertakes to repair or replace (at Retell’s option) equipment supplied that develops a fault within 1 
year of the date of purchase subject to the following conditions: 

1. The equipment has not been subject to misuse, liquid damage, accidental breakage, neglect or any 
other use other than for the purposes of recording conversations or memo’s. The guarantee does not 
cover any batteries or cassette tapes supplied by Retell or any damage caused by leaking batteries. 
(We advise that batteries are taken out of the battery compartment where long periods without using 
the equipment are envisaged. e.g. holidays etc). 

2. The equipment has not been tampered with or adjusted internally by anyone other than Retell or their 
appointed agents. 

If a defect occurs the equipment should be returned to your supplier in the first instance. Alternatively you 
can return it pre-paid to Retell in protective packaging containing a full explanation of the fault and proof of 
purchase. Retell does not accept liability for damage in transit and we strongly suggest using Recorded 
Delivery to prove receipt. 
 
This guarantee does not affect your statutory rights. 
Retells full terms and conditions are available upon request. 

Liability 
Retell expressly excludes to the extent permitted by law liability for any consequential loss, damage or injury 
arising from or in connection with any Retell product. No liability can be accepted for any loss of data or 
recordings or failure to record or consequences of such loss. 

http://www.ofcom.org.uk/
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R&TTE Directive 
We hereby declare that this product complies with the essential requirements of directive 99/05 (the R&TTE 
directive). 
To obtain a full copy of the declaration associated with this product then please contact Retell at the address 
below 
Retell, 53 Thames Street, Sunbury on Thames, Middlesex, TW16 5QH 
Tel 01932 779755  
Fax 01932 780383  
E-mail admin.buying@retell.co.uk 
Website www.retellrecorders.co.uk  

mailto:admin.buying@retell.co.uk
http://www.retellrecorders.co.uk/
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Support 
If you should require help setting up or operating your equipment then you can contact Retell by any of the 
following ways: 
 
E-mail: technical.helpdesk@retell.co.uk 
 
Phone: 0871 42 42 444 
 
Fax: +44(0) 1932 780 383 
 
Post: Retell, 53 Thames Street, Sunbury on Thames, Middlesex TW16 5QH ENGLAND 
 
 

Customer Comments 
Retell aims to continually improve instructions. Please e-mail your comments to sales@retell.co.uk 
 

mailto:technical.helpdesk@retell.co.uk
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